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Welcome 
Thanks for choosing RapidWeaver to build your next great website. This all-new manual 
for RapidWeaver 7 is designed to get you up and running quickly, while also providing a 
full reference guide to everything you can do with RapidWeaver. When the manual refers 
to an item that you can use in the RapidWeaver interface, we’ve highlighted the name of 
the option to look for: e.g. Re-Publish All Files. The same applies to keyboard 
shortcuts: e.g. Cmd 8.  

We’d like to say thank you to all those who’ve helped shape RapidWeaver 7 - especially to 
the third-party developers and beta testers who’ve made sure this is best release of 
RapidWeaver ever. Happy Weaving! 

     — The Realmac Team, Brighton, England, April 2016 

RapidWeaver is a registered trademark of Realmac Software Limited.  Any other trademarks used in this manual are 
the property of their respective owner, and hereby acknowledged.  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Chapter 1 

Upgrading to RapidWeaver 7 

No matter which version of RapidWeaver you’re upgrading from, RapidWeaver 7 has a 
host of new features. Here’s how to make the move! 

Upgrading from RapidWeaver 6 

1. Launch RapidWeaver 7. You’ll receive a notification that your addons are being copied, 
and another when your addons have been copied. Your preferences from RapidWeaver 
6 (including licenses for plugins such as Stacks) will automatically be copied to 
RapidWeaver 7. 

2. Once your addons have been copied, locate your RapidWeaver 6 project file in the 
Finder - it’ll have a .rw6 extension. Right-click (that’s Ctrl - Click to the longer-term 
Mac users out there!) on the project. 

3. Choose Open With… and choose RapidWeaver 7. 

4. RapidWeaver 7 will copy the contents of your old project into a new .rw file - this is a 
file specifically for RapidWeaver 7, and you should make sure you open this project file 
in future. Your new .rw file will be created in the same location as your RapidWeaver 6 
project file, and the original will be left untouched. 
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Upgrading from RapidWeaver 5 & Earlier 

When upgrading from RapidWeaver 5 or earlier, you’ll need to download a copy of 
RapidWeaver 5.4.1 to your Mac and be running OS X Yosemite or newer. RapidWeaver 
5.4.1 is a free download, and you can use the demo version to get your projects ready for 
RapidWeaver 7 - there’s no need to enter a license. 

1. Make sure that any third-party plugins you use in RapidWeaver 5 are up to date - the 
RapidWeaver Community website can help with this. When you download any 
available plugin updates, make sure you choose versions for RapidWeaver 5. 
RapidWeaver 5 plugins have a .rwplugin file extension. 

2. Open your older project files (either with a .rwsw or .rwp extension) with RapidWeaver 
5.4.1, and then save the project, to ensure it’s in a format that RapidWeaver 7 can read. 

3. Download the latest version of RapidWeaver 7 from the Realmac Software website, and 
move it to your Applications folder. 

4. Launch RapidWeaver 7, and when asked whether you’d like to copy your addons click 
Copy Addons. RapidWeaver will copy over your themes, stacks, theme styles and 
other addons. Recent projects will not be copied over, as RapidWeaver 7 is a new app, 
and OS X only tracks recent projects as they are opened with each different app. 

5. When your addons have been copied, you’ll receive a notification via Notification 
Centre, and can then use the View menu’s Manage Addons option to verify 
everything is in place. Click on the Plugins filter to see the plugins that are installed. If 
any of your plugins are missing, visit the RapidWeaver Community website download 
the latest version. RapidWeaver 7-compatible plugins have a .rapidweaverplugin file 
extension - plugins with a .rwplugin extension are not supported. 
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Running Multiple Versions of RapidWeaver 

When installing RapidWeaver 7, we’d recommend removing older versions of 
RapidWeaver from your Mac by placing them in the Trash. However, if you’ve got some 
projects that you don’t want to migrate to RapidWeaver 7, you may well keep an older 
version on your Mac just in case. 

As each version of RapidWeaver is a standalone app, any addons used in RapidWeaver 7 
are separate from the addons used by RapidWeaver 5 and RapidWeaver 6. When you have 
multiple copies of RapidWeaver on your Mac, you’ll need to take a slightly different 
approach when installing addons. This is because each version of RapidWeaver notifies 
OS X that it can accept the addons you wish to install, however it is OS X itself that 
determines which version of RapidWeaver to launch when you double-click on an addon. 

To ensure addons are installed for use with your intended version of RapidWeaver, right-
click on the addon, choose Open With… and choose RapidWeaver 7. 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Chapter 2 

New in RapidWeaver 7 
RapidWeaver 7 has some great new ways to build a better website. We’ll cover these new 
features in-detail in the coming chapters, but whether you’re new to RapidWeaver or not, 
it’s helpful to know what’s new besides the app’s tweaked and refined design. You can 
keep track of every change in RapidWeaver (all the way back to November 2004!) via the 
RapidWeaver Release Notes page.  

Health Check 
Health Check analyses your site and provides you with a list of suggested changes to make 
your site load quicker, and be more-easily indexed by search engines. 

Multiple Publishing Destinations 
If you need to publish a project to a preview server - to verify everything’s working, or 
perhaps to show a client - RapidWeaver now allows you to change between different 
servers with a couple of clicks. RapidWeaver also remembers the Smart Publishing status 
of all pages across multiple destinations, meaning that only changed files need to be 
uploaded. 

Local Publishing 
Previously known as Export, Local Publishing now means that exporting a local copy to 
your Mac is as quick and easy as regular publishing. RapidWeaver uses smart publishing 
to track changes too. 

Project Backup 
When publishing your website, RapidWeaver can optionally upload a ZIP file that 
contains your RapidWeaver project file. You can locate the backup via the Publishing 
Settings, by clicking Download Backup. 

Multiple Selection in Page List 
The page list determines the layout of your website’s navigation. Multiple selection allows 
you to bulk-reorder or delete pages and resources. 

Banner Images 
You can now add a banner image to your project. It’s separate from the Site Logo, and can 
be customised for every page. In order to use this feature, your projects must be using a 
theme that supports banner images. 
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Improved Media Browser 
Now with support for Adobe Lightroom, and dragging in folders from the Finder. 

More Site Wide Code Areas 
We’ve merged the “Google Analytics” and “GoSquared” fields from earlier versions of 
RapidWeaver into the Site Wide code areas: they’re now part of the “Head” and “Body” 
areas respectively. This change means you can add even more code to your RapidWeaver 
projects, and keep it all in one location. 

User-Selectable Addons Folder 
Need to keep your addons in a different folder? You can now choose (and optionally move 
addons to) a new location such as your Documents folder, or Dropbox. 

New Themes 
There’s two new themes included with this upgrade, both of which take advantage of the 
new Banner Image feature. They’re called Voyager and Kiki, and there’s example projects 
to show how they work included in the Projects window. 

Even more changes! 
There’s also a host of substantial performance improvements - particularly when 
previewing or saving your projects. You can read a full list of changes on the RapidWeaver 
Release Notes webpage. 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Chapter 3 

Getting Started 
Registering RapidWeaver 
When you open RapidWeaver for the first time, you’ll see this registration window: 

If you’re trying out RapidWeaver, simply choose Use Demo for now. RapidWeaver is free 
to use for small sites, allowing you to add up to three pages per project without any time 
limit - there are no other limits imposed when running the demo. If your site out-grows 
the three page limit, use the RapidWeaver menu’s Register… option to visit the 
Realmac Software store and complete your order. Your RapidWeaver license will be sent 
to you via email, and displayed in your web browser once the order is complete. 

Copy and paste your RapidWeaver license in to the box and press Register. RapidWeaver 
will validate and activate your license over the internet, and once that’s done press 
Continue to get started. 

Projects Window 
After registering RapidWeaver the Projects will appear. 

When the Projects window is shown for the first time, RapidWeaver takes you to the 
Examples tab. This area shows the five included example projects, built by some of the 
best third-party addon developers. Each project highlights one of the modern, responsive 
themes included with RapidWeaver and includes a selection of different pages, meaning 
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you can use these examples as a starting point for your own projects. Any projects you 
create in RapidWeaver will appear in the Recent tab - and for ease of use, RapidWeaver 
will remember your selection of either Recent or Examples. 

Note: The number of Recent sites that RapidWeaver lists will depend on the 
setting in System Preferences’ General tab, and the list of files is derived from 
the OS X “Recent Files” list. 

In this tutorial, you’ll build a project from scratch so that you can understand how the 
example sites are made, so select New Project in the Projects window. You can also use 
the File menu’s New Project option, or the keyboard shortcut Cmd Shift N. 

Create A New Project 
The new project is empty right now, so let’s add a page to the project by choosing Add on 
the main toolbar, and selecting a Markdown page. 

The Add menu shows all the available page types (sometimes referred to as “plugins”) that 
you can add to a RapidWeaver project. The Add menu will adapt as you use RapidWeaver, 
suggesting your most recently used plugins, and you can view all the plugins available by 
choosing All Plugins. Get started by adding a Styled Text page to your website. 

With a page added to your site, let’s add some content to this page! 

We’ll start by adding an image to the page - you may have an image already exported to 
the Finder, or have an image from your Photos.app library in mind. To insert an image 
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into a Styled Text page, drag the image from the Finder onto the desired line on the page. 
You can open the iMedia Browser with Cmd 4 to browse Photos.app, iPhoto & Aperture 
(if you’ve not yet upgraded to Photos), and Lightroom. 

Designing Your Website 
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RapidWeaver includes over fifty varying templates known as “themes”, including a 
number of modern responsive designs that you can use. With a page now added to your 
project, choose Preview on the main toolbar to get your bearings (you can also toggle 
Preview mode with the keyboard shortcut Cmd R). By default, RapidWeaver will apply 
the “Offroad” theme to your site to preview your content. We’re going to browse the 
available themes by toggling the Themes option on the main toolbar. 

The Theme Browser allows you to apply any theme with a single click - you can customise 
each theme further once it’s selected. The Theme Browser allows you to search, select a 
specific folder (for example, to only show the more modern themes), and duplicate the 
themes to make modifications. 

Once you’ve selected a theme, choose Master Styles in the Page List. The Master Styles 
area contains the variations available as part of your selected theme, and allows you to 
customise the theme across your entire site. Master Styles is the best way to lay your 
entire site out, but if you need to customise the layout of a single page don’t worry - you 
can override your site-wide Master Styles on a per-page basis if you need to! 

Note: Master Styles allow you to make site-wide changes to the theme 
variations that are applied to every page in your project - something that 
wasn’t always possible in previous versions of RapidWeaver. If you’re an 
existing RapidWeaver user, Master Styles will allow you to make site-wide 
changes with a single click - and we strongly recommend that you consider 
adopting Master Styles for projects to save you time. You can learn how to do 
this in Appendix B. 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Chapter 4 

The RapidWeaver Interface 
Here’s a quick visual guide to the RapidWeaver interface. 

The Page List 
Any page that you add to your RapidWeaver project appears in the Page List, and the 
navigation menu for your website is based on the layout of the pages in the Page List. 

You can drag-and-drop pages to re-order, or drag pages onto other pages to create a 
nested page. You can also re-order the different groups (Pages, Resources, and 
Settings) in the Page List. 

You’ll also notice a blue dot appearing to the right of each page: this signifies that there 
are changes that have yet to be published. When the changes to each page are published, 
the blue dot is hidden. 

Right-clicking on a page in the Page List displays a contextual menu with some useful 
options, including to Duplicate a page, or Mark As Unchanged (and the blue dot for 
the page will disappear). 
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Just like in other apps, you can edit the name of any Page List item by double-clicking it. 

Finally, the Page List also supports multiple selection, both of pages and resources (which 
we’ll cover shortly). When the Page List has focus, you can use Cmd A to select all Pages 
(or resources, if a resource is selected), or Cmd Shift A to select All Pages and Resources. 
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So What Are Resources? 
Every website is made up of content, first and foremost, but there’s always some 
additional files that need to be uploaded with the content - perhaps it’s a PDF that visitors 
can download (or view in their browser). That’s what Resources are for - the files that 
make up your site, but aren’t tied to any individual page. 

You can add your first resource by taking a file from the Finder, and dragging it into the 
Resources sidebar item - or by clicking on the sidebar item itself. 

Each resource you add to your project can be linked to from any page on your site, or 
depending on the file type (for example an image) you could take the resource and embed 
it in the content area of a particular page. 

Using Resources 
There’s two incredibly useful ways to make use of resources. Firstly, when using 
RapidWeaver’s “Add Link” feature, when there are resources in your project file you can 
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directly link to them (and RapidWeaver will automatically generate the correct link to the 
resource, no matter where in your project the page is located). 

If you need to embed the image, or have use for the image’s address, instead of hardcoding 
the link you can use what’s known as a resource macro. Whenever a resource macro is 
found in your project, RapidWeaver will substitute it for a link to the resource. 

%resource(image.jpg)% becomes a path to a resource called image.jpg. If the resource is 
inside a folder, be sure to include the name of the folder in your macro: 
%resource(folder-name/image.jpg)%. 

Note: To save time, RapidWeaver can generate a macro for you. Hold 
Option while clicking on the link button to copy the resource’s macro to the 
clipboard. 

Settings 
Beneath pages and resources is the Settings area. It contains a number of useful options, 
and allows you to configure everything from the site name, to publishing details, and save 
notes with the project file. 
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General 
The General area contains a number of site-wide options that relate to your published site: 
the name, website address, logo, banner image etc, they’re all handled here. Many of the 
options in the General view (with the exception of the Website address, favicon, logo, and 
WebClip icon) can be overwritten on a per-page basis in the Page Inspector. 

Code 
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The code area provides areas where you can insert code onto every page on your site. Site 
wide metatags, analytics code, and other advanced code snippets can be placed in the 
respective section and will be applied on every page in your project. 

Master Styles 
Using Master Styles, you’ll be able to lay out your site with just a few clicks. For more 
details, refer to “Designing your Website” in Chapter 3. 
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Notes 
If you’re working on a project and need to make notes as you go (perhaps for the next time 
you’re working with the site, or handing the project file to a co-worker), you can write in 
the Notes area using Markdown. This content remains in the project file, and is never 
published. 

Publishing 
When you’re ready to publish your RapidWeaver site, the Publishing view. You can 
configure RapidWeaver to publish your website to more than one location - for example, a 
preview server, and a live server. You can learn more about publishing your site in the 
next chapter. 

Addons Manager 

RapidWeaver is infinitely expandable, with a range of themes, plugins (page types), and 
other addons available to customise your site. The Addons Manager allows you to view all 
the addons installed within RapidWeaver. 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From here, you can remove addons from RapidWeaver using Right Click, place addons 
into collections (for example, all the addons in use for a particular project or client), and 
quickly visit the RapidWeaver Community. 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Chapter 5 

Health Check 
The code that RapidWeaver generates is designed to help your site load as quickly as 
possible, and wherever possible the app will look to optimise your site. To help optimise 
your site, Health Check will analyse your project settings and let you know about 
enhancements you can make to your site. 

Project Setting Checks 

RapidWeaver will run the following checks on your project to see if the features are being 
used, or need tweaking. 

- If your site is using the new banner image feature, and an alternate label has not been 
specified, you’ll be prompted to add one. 

Page !  of !22 84



- If you’ve chosen to add a logo to your project file, but have not set an alternate label, 
Health Check will warn you about this. 

- CSS Consolidation helps to keep your sites loading quickly. It’s recommended for all 
sites, and enabled by default on new projects. 

- Tidied URLs help your sites be better-discovered by search engines. 

- Minification helps compress your CSS and JavaScript. It’s enabled by default for new 
projects, but if you’re upgrading a project from RapidWeaver 6 it is not automatically 
enabled. 

- Missing Favicon & WebClip icons ensure your website’s identity is shown in the browser 
and when your website  

- XML Sitemaps help search engines know about the pages in your project. RapidWeaver 
can generate one automatically, and submit it on your behalf.  

- Keep up to date with the latest versions of your plugins. Health Check will let you know 
if there are plugin updates available. 

Page Checks 

- It’s important to give your pages a descriptive title - not only does this appear in the 
name of the tab of your browser, it’s used by search engines as your web page’s name in 
search results. Health Check will flag any missing, or overly-long Browser Titles. 

- Giving your webpages descriptive URLs can help people find content on your site. If 
you’ve got folder names such as “page58”, RapidWeaver will flag this to be fixed. 

- Description Metatags are a useful addition to your pages, and are normally shown as the 
blurb beneath a web page’s name in search results. Health Check will check whether a 
description metatag has been entered in the Page Inspector’s SEO tab. Any hand-coded 
HTML will not be analysed. 

- Giving your images descriptive filenames can help search engines index your page. 
Health Check will highlight any images with generic filenames. 

- In addition to descriptive filenames, you can improve the accessibility of your website by 
using the Alt attribute to describe the image’s content. This will be used by screen-
readers, or when a visitor chooses not to show images on webpages. 

- RapidWeaver will analyse links that point to pages that no longer exist inside your 
project. Health Check will not check links entered by hand - only those selected via the 
Add Link sheet’s popup menu. 
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Note: In RapidWeaver 7, there’s some new features to improve the 
performance of your site: cache-busting, and CSS and Javascript 
minification. They’re enabled by default for new projects - existing projects 
will show these new features as “Fix Its” in Health Check. 
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Chapter 6 

Live Previews 
New in RapidWeaver 7 

The preview system in RapidWeaver 7 has been completely reworked to provide 
substantial speed increases, the ability to reliably preview all PHP inside RapidWeaver, 
and some magical ways to work with RapidWeaver and your favourite browser. Here’s 
how to make the most of it. 

1. Open a project file, and stay in Edit mode. 

2. Use Cmd + P to preview your website in your default browser. 

3. Go back to RapidWeaver, and make any changes in Edit mode. 

4. Return to the browser, and see the changes reflected. 

The live preview in Safari or Chrome also allows you to navigate around your 
RapidWeaver project. Simply follow your site navigation in Safari, and RapidWeaver will 
switch pages in the background, making it easier than ever to make changes. 

Note: Live previews, and the ability to navigate your site in the browser, are 
only available while RapidWeaver is open. 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Chapter 7 

Publish Your Site 
Publishing your site is an exciting moment: you’ll be able to enter a website address into 
Safari, and see the fruits of your work. So let’s get started! 

Depending on who your hosting provider is, you may need to tweak a few options in 
RapidWeaver before you publish your website. This is entirely normal, and is simply due 
to web hosts having different requirements when it comes to publishing your site! 

Most importantly, you’ll need to bear in mind that the details you enter into RapidWeaver 
are supplied by your hosting provider, not RapidWeaver or Realmac Software. Many 
hosting providers will require you to use publishing details that differ from any details you 
may use to access their control panel in a web browser. While this may be frustrating, it’s 
designed to keep your private information safe! If you are at all unsure about what to enter 
into RapidWeaver, drop your hosting provider an email and they’ll be able to advise you. 

RapidWeaver publishes websites using a technology called FTP, which nearly every 
hosting provider supports. Three different flavours of FTP can be used: FTP, FTPS and 
SFTP (sometimes know as FTP over SSH). Some hosts may require a specific variant of 
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FTP, and most support more than one. One thing you should note is that FTPS is the 
rarest of the variants, so if you’re asked to enable it we recommend clarifying that with 
your host! 

Note: There are substantial differences between FTPS and SFTP publishing, 
and despite the similarities in name they’re very different upload methods. 

Need Hosting? 

RapidWeaver works with almost any host (and if you’ve already sorted some web hosting, 
you can skip ahead now!). If you’re still deciding on a hosting provider, and are looking for 
a company with its roots in the RapidWeaver community, LittleOak is the official hosting 
partner of Realmac Software. Every aspect of LittleOak’s hosting is built to ensure 
absolute compatibility with RapidWeaver, and all the friendly support staff at LittleOak 
are all familiar with RapidWeaver. 

Visit LittleOak to learn more about their official RapidWeaver hosting service. 

Publishing to an FTP, FTPS or SFTP Server 
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Server 
This is the address for the online server that hosts your site, and is required to publish 
your site. In many cases it looks like a regular web address (e.g. ftp.mysite.com), or is 
exactly the same as your domain name. Some hosts require that you use a particular port 
number to connect. To specify a custom port number, add a colon and the port number to 
the end of the server address you enter, e.g. ftp.mysite.com:404 

Username 
Your username is part of the identity used to authenticate with your web host. Make sure 
the username is exactly as your host supplied it - check zeros are not Os, and that the case 
of every letter matches. 

Note: RapidWeaver does not support anonymous FTP login. 

Password 
When entering your password, make sure the password is exactly as supplied by your web 
host. Check the number of characters in the password field match the password given to 
you by your host, and when copying and pasting be careful not to copy any extra 
whitespace or characters. You can use the “Reveal Password” option to show the password 
- when you reveal a password, the password will be selected to easily show any extra 
whitespace at the beginning or end of your password. 

Passwords that you enter into RapidWeaver are stored securely in the OS X Keychain - 
RapidWeaver never stores passwords in your RapidWeaver project. Instead, RapidWeaver 
stores a reference to the Keychain in your project, and requests the password from your 
Keychain when publishing a site. 

Path 
When publishing your website, RapidWeaver needs to know which folder to place your 
website into on your host’s server. The “path” is used to describe the location of this folder 
to an FTP app. The most common publishing issue is an incorrect publishing 
path - this is because the path varies greatly from host to host (or sometimes even 
between different hosting packages with the same company!). If you don’t know what your 
publishing path is, contact your hosting provider. 

Note: In some cases, you may not require a path at all - in this case, you can 
just leave the Path blank. A blank path tells RapidWeaver to publish your site 
to the folder your server provides when the app logs in. 

Test Connection 
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We strongly recommend that you use the Test Connection feature to check your 
credentials are correct before publishing your site. 

FTPS Connection Settings 
When publishing using FTPS, there are several different modes that web hosts can use to 
authenticate you. As apps cannot reliably detect the necessary FTPS settings when 
publishing, you may need to try the Use SSL for menu options before you can 
successfully publish. 

Publishing to a folder on your Mac 
New in RapidWeaver 7 

RapidWeaver 7 replaces the previous “Export” feature with full-blown local publishing. 
You can add a folder as a publishing destination, just as you would add an FTP server - 
and with RapidWeaver now supporting multiple publishing destinations, you can use 
Smart Publishing to export changes incredibly quickly to any destination. To add a new 
local folder destination, go to the Publishing item in the Page List, and choose Add New 
Destination. 

In the Publishing Method pop-up menu, choose Local Folder.  

To select the folder RapidWeaver should publish to, click on Choose Folder…, and 
navigate to your preferred folder. When you’re in the right location, click Choose to set 
the location and close the folder selection panel. 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Working with Multiple Publishing Destinations 

When you have multiple publishing destinations configured, you can easily switch server 
by clicking the drop-down menu beside the Publish button, and selecting a different 
destination.  

By default RapidWeaver gives each destination a generic name, but to make it easier to 
identify them you can change the name by going to the Publishing item in the Page List. 
Then, simply click on the name at the top of each destination and start typing. The name 
of the currently-selected destination will show under the toolbar’s Publish item. 

Project Backup 
New in RapidWeaver 7 

When RapidWeaver publishes your website, an optional backup of the RapidWeaver 
project file can be uploaded at the same time. The project file is compressed as a ZIP file, 
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and is placed in a secret folder on your website, meaning that if you know the address it 
can be downloaded and re-used. You can enable backups to happen every time you 
publish, or on a less regular schedule. Backups only occur when your site is published, and 
do not happen in the background. 

Note: RapidWeaver does not store your publishing password in project files. 
Your server address and username are stored in the document, with the 
password securely stored in the OS X Keychain. When saving your projects, 
RapidWeaver receives a reference to the keychain item from OS X, which it 
then stores in your document. In short: your password stays private, and you 
don’t need to re-enter your password on any Mac that has your publishing 
password in the Keychain. 

Project backup will increase the amount of time taken to publish your website. 
RapidWeaver cannot use multiple concurrent connections to upload a backup, as 
concurrent connections can only be used to upload different files. 
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Advanced Publishing Setup 

RapidWeaver supports a wide variety of publishing configurations, including Active Mode 
FTP, three different methods of FTPS authentication, and FTP with SSH Key 
Authentication. If your host requires this, or you’ve chosen to use SSH Key authentication, 
read on! 

Note: Due to the varied, and sometimes complicated, nature of SSH 
authentication, we can only offer limited technical support when using an 
SSH-based setup. We only recommend using SSH Key Authentication if you’re 
familiar with key-based authentication, and are aware of how SSH keys are 
stored on your Mac. 

Publishing with SSH Keys 

While password-based FTP is still the most common way to upload to a web host, 
RapidWeaver also supports authentication using SSH keys. SSH keys are a great way to 
allow multiple users to access your web hosting over an encrypted connection, without 
needing to share a password. Each user generates a pair of cryptographic keys on their 
Mac - one private, one public. The public key (which is uploaded to your web server) can 
then be used to verify that a private key is permitted to access the server. 

Check with your web host to see if they support SSH key authentication - the instructions 
for getting an SSH public key onto your server will vary between hosts. You can learn 
more about generating SSH keys using GitHub’s guide.   

Set Up SSH Key Authentication 

In this guide, we’ll assume that you’ve already generated a private/public key pair, and 
that your server configured with your public key. Start by selecting SFTP as your 
publishing method: enter the server, username and path details, and then check the Use 
Public Key Authentication option. 

You’ll now need to enter a few further details: the locations of your private and public 
keys, and the passphrase for your private key (if there is one). 

With your keys selected, run a test with your credentials to ensure they’re valid. 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Chapter 8 

Improve Your Site 
Knowing who visits your site can be incredibly useful. Now that we’ve published your site, 
let’s look at ways of measuring how the site is performing. Initially we’re looking to make 
sure visitors are coming to your site (and how they’re discovering it). To do this, we’re 
going to add some simple code snippets to your RapidWeaver project that allows you to 
view visitor statistics via either Google’s free Analytics service, or a free GoSquared 
analytics account that’s included with every copy of RapidWeaver. 

If you’ve never used Google Analytics before, this Moz.com guide explains the basics. 

Google Analytics 
At the end of the Google Analytics registration process, you’ll be asked to add a site to your 
account. After entering your website address, Google will present you with the code that 
you need to carefully copy, and enter into RapidWeaver. You should place the code that 
Google provides into the Code item in the sidebar, under the Body sub-tab. 
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Google Webmaster Tools 
While Google Analytics provides you with details of how people are using your website, 
Webmaster Tools is a free service that allows you to see any potential issues for search 
engines that visit your site. The service highlights potential issues with broken links, 
missing sitemaps, and dozens of other items that may impede your appearance in search 
engine results. 

SEO 
Search Engines use a wide variety amount of different “signals” to judge the quality of a 
page - everything from the speed that a page loads, to the quality of the links to the page 
and the number of times any given phrase appear on each page. Unlike the early days of 
search engines, where pages could easily “game” their way to the top of a results page with 
keyword density, almost every aspect of your site can be used to rank it. 

Google produces a great SEO Starter Guide to teach the basics - and there’s also a number 
of tools that you can use to inspect how your site performs once online. We’ll show you 
some of these in the next chapter, but first let’s make sure we cover the fundamentals that 
you site should include before we publish it! 

The Importance of Mobile 
In April 2015 Google started gauging how mobile-friendly your website is, and uses 
mobile-friendliness as part of its ranking algorithm. 

The good news is that, if you’re using a responsive theme, this means you need to do 
absolutely nothing! There’s a number of themes in RapidWeaver 7 that are fully 
responsive (check out the New Themes option in the Theme Browser) which, in 
combination with any of the built-in plugins or version 3 of the Stacks plugin, allow you to 
build a fully-responsive site that works beautifully for mobile devices and desktop 
computers! 

Optimise your Site 
Over the years, we’ve learned a few tips about how to make your website sing when a 
search engine visits it. Here’s some top tips for preparing your website - we recommend 
you run through this checklist before you publish your site for the world to see! This 
checklist also forms the basis of RapidWeaver 7’s new Health Check feature - to get 
started, click the Health Check toolbar item and run a check! 
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- Make sure you’ve added descriptive browser titles in the RapidWeaver Page Inspector. 
Don’t be overly-verbose, or potentially spammy. Google and other search engines 
penalise sites that use “keyword stuffing” (the practice of cramming in lots of keywords 
you’re wanting to appear under). 

- Use concise but descriptive filenames for webpages. For example, the Realmac Software 
About page uses http://realmacsoftware.com/company as its web address. Keep website 
addresses short - some users will attempt to guess the address of pages, and http://
realmacsoftware.com/about-realmac-software-app-studio-brighton-website-creation-
rapidweaver isn’t that guessable. 

- Test your website on a few different devices to gauge how the page displays, and how 
quickly it loads. If your site is responsive, don’t fret about making your site layout pixel-
perfect at any given screen size. The whole point of responsive design is to allow the 
content to dynamically reflow: as long as there’s no quirks or overlapping content, 
you’re good to go. 

- Make sure you’ve added concise description metatags in the RapidWeaver Page 
Inspector for every page. While “description” metatags are no longer used by Google to 
determine your page’s ranking, they are used to generate the short snippets on Google’s 
results page. e.g. “Learn more about RapidWeaver, the award-wining website creation 
app for Mac”. 

- Add “Alternate” descriptions to images in the Media Editor. Double-click on every 
image in your site, and in the popover ensure that the Alt Tag is something meaningful 
and human-readable. The Alt tag is shown when an image isn’t downloaded, and helps 
visitors who may not display images (e.g. visitors with a visual impairment may be using 
a screen reader to read pages aloud, or users using on a mobile connection while abroad 
may choose to disable images to avoid expensive roaming charges). Don’t try and over-
load this with extra information, simply describe the content the user would otherwise 
see, and avoid generics such as “Logo” or “Button”. If you’re using photos, you may want 
to describe the content of the image: “Brighton Pier at Sunset”. 

- Use the built-in Search Engine Sitemap feature. RapidWeaver automatically adds your 
pages to a special, machine-readable, XML file that is automatically submitted to Google 
and other search engines on your behalf. If you want to hide a page from this sitemap, 
you’ll need to uncheck the Show in Navigation option in the Page Inspector. 

- Use CSS consolidation (a feature that is automatically enabled on new projects), to 
ensure your pages download and display as quickly as possible. RapidWeaver brings 
together all the files that layout your site into as small a number of files as possible, and 
removes unnecessary whitespace. This means that pages load quicker, and depending 
on the theme, ensure compatibility with older legacy browsers which placed a limit on 
the number of CSS stylesheets a page could use. If you haven’t enabled this feature yet, 
Health Check will help you enable it on existing projects. 
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- Consider using Open Graph and Rich Data code on your pages. When adding code to 
your site, it’s worth remembering that it’s just one of many things you can do to your 
site - especially as search engines use more than just machine-readable data to analyse 
your site. That said, giving search engines some hints about the page’s content offers 
more data that can be analysed and used in other locations. Just like description 
metatags on your pages, Open Graph and Rich Data code can help make Google aware 
of a product, company, or review that’s on your page - and consider displaying extra 
information when your page appears in search results. 

As with all SEO tips, be aware that these are merely a set of suggestions, and not all-
encompassing ways to appear on your chosen results page. Google uses a huge number of 
different “signals” to rate your page, and ensuring there’s great content to make it worth 
while for visitors should be your primary focus before embarking on any optimisations 
specifically for search engines! 

Remember also that changes made to your website will not instantly impact your 
appearance in search results, and it could be a month or more before substantial changes 
have any effect. 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Chapter 9 

Page Style Reference 
Styled Text 
The Styled Text page is one of the most commonly-used page types in RapidWeaver. It’s 
flexible enough to enable you to style content with rich text formatting, but extensible 
enough to allow the more code-savvy among us to place in HTML if you need it (e.g. 
pasting in an embedded YouTube video). 

Getting Started 
Let’s get started by adding some text. You can write in RapidWeaver, or paste in content 
from other apps. If you’re pasting in from Microsoft Word, we recommend you use the 
Edit menu’s Paste as Plain Text option. This will ensure that any unusual formatting from 
Word is not transferred to your website. 
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Working with Images 
Styled Text pages support JPEG, PNG and GIF images, which can be added to your page 
via Drag and Drop or via the iMedia Browser (available on the View menu). If you need to 
make some adjustments to the image, open the Media Inspector by double-clicking on the 
image, where you can scale, rotate, and rename the image. 

We recommend you give each image a non-cryptic filename such as “realmacsoftware-
logo”, and ensure that you fill in the Alternate text field. This alternate field will be shown 
to visitors who may have images turned off (or are viewing your site on a slow 
connection), and is a great way to improve the accessibility of your website. 

Note: The new Health Check feature will highlight any images that could use 
a new filename or alternate label! 

Using HTML Code in Styled Text pages 

RapidWeaver’s Styled Text pages, and any other page types that use the styled text areas 
available to plugins, also allow you to paste in HTML. To ensure your code appears as you 
expect, you should identify blocks of code as such by choosing Format > Ignore 
Formatting. By using this option, you’re telling RapidWeaver not to alter or stylise the 
content. 

So what should you do if you’ve got code that you want to show as an example on your 
website? Highlight the block of code and then use the Format > HTML > Code. This 
will apply the appropriate HTML tags to ensure the code is displayed properly when 
previewing and publishing the site. 

Markdown 
Markdown is one of the most popular ways to write for the web. By using a lightweight, 
and easy to read, syntax you can write and edit text without having to wade through 
HTML. 

You start writing, and when previewing or publishing your Markdown pages, 
RapidWeaver will generate the HTML for you! 

The Basics 
**Text contained within sets of two asterisks appears in bold** 
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_Text with an underscore on either side area is shown in italics_ 

[This text will link to the Realmac Software website](http://realmacsoftware.com) 

Learn more about Markdown 
Markdown is incredibly simple to get started with. There are also some advanced options 
that you can make use of - for a complete list of Markdown syntax that you can use, visit 
the official Markdown documentation. 

Photo Album 
RapidWeaver’s Photo Album page makes it quick and easy to build online photo albums 
and slideshows that look great on desktop and mobile. 

Getting Started 
Start by going to the Add option on the main RapidWeaver toolbar, and add a Photo 
Album page to your project. 

With a Photo Album page added to your site, you can now drag in any image files from the 
Finder or RapidWeaver’s built-in Media Browser (available via the View menu). Images 
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added a photo album page are copied and saved within your project file, so that you can 
always export and publish your site. 

Blog 
The Blog plugin allows you to manage a collection of blog entries; recording personal 
events, thoughts, ideas and more. Audio and video files can also be added to blog entries 
to create Podcasts – all of which can be syndicated using RSS feeds. 

  

Adding a Blog Entry 
To add a new blog entry, click the + button. When you create a new post, the list at the top 
of the plugin view will show the new entry, and the editor beneath will allow you to create 
your post. 

The Post Settings area is shown on the right of the main window. Here we can edit a post’s 
Title, Category or Tags. The date and time for each post is set automatically to the time the 
entry was created at: the time of a post can also be edited manually, or by pressing the 
Refresh button next to the Date field to set it to the current time. 
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Note: RapidWeaver’s blog post does not schedule posts - any post that is checked in the 
post list will be published, with your chosen date applied. 

Double-click within a blog entry’s Title field to add or edit its title. 

Add your content to a blog entry in the main content area, located in the bottom half of the 
main window. 

The main content area for each blog entries is a regular Styled Text area, as found 
elsewhere in RapidWeaver, allowing you to easily write and add images, movies, links and 
HTML. 

Permalinks 
A Permalink is a permanent link to a specific blog entry so that visitors may return to it 
even if it has been archived and moved off the main Blog page. When enabled in the 
General tab of the Blog’s Setup area, RapidWeaver will automatically create a Permalink 
for each blog entry. If you’d like to create a custom Permalink for a specific blog entry, 
enable the ‘Custom Permalink’ checkbox and type in a unique word or phrase (e.g. 
‘my_first_post’) into the Permalink field. When RapidWeaver publishes your blog page, 
the blog post will be shown in a file with that name. 
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Note: RapidWeaver automatically appends the file extension (.html or .php) 
depending on the page’s setting in the Page Inspector. 

  

Podcasting 
RapidWeaver allows you to easily add Podcasts to your blog entries. Podcasting is a 
standard that allows audio or video files (most commonly in MP3 or MP4 formats) to be 
published online in a way that allows Podcast-capable applications such as iTunes to 
automatically subscribe to them and download the media for playback at the listener’s 
convenience. 

When you add a Podcast to your blog entry by clicking the Add Podcast... button, 
RapidWeaver presents a Podcast sheet that allows you to drag-and-drop your Podcast 
media-file into your blog entry. The file needs to be in a QuickTime compatible format 
such as MP3 (audio) or MP4 (video and audio). Once the media file is dragged in, you can 
specify custom tags to help iTunes to correctly categorise your podcast. The custom iTunes 
tags are applied on an episode-by-episode basis using the iTunes Tags tab. 

Using External Audio Files in your Podcast 
If you wish to refer to existing online content, do not drag in any media to the initial 
podcast drop- box. Instead go to the Custom RSS Tags tab and check the ‘Over-ride 
default Podcast settings’ option. Simply enter the full URL to the media e.g. http://
realmacsoftware.com/podcast.mp3. 

Be sure to enter the full data for the size in bytes in the size box and specify the correct 
MIME type. You can get the full size, in bytes, by using the Finder’s Get Info on your 
audio file. Podcast ‘enclosures’ can be in the following formats: 

- .mp 

- .mp4 

- .m4a 

- .m4v 

- .mov 

- .pdf 

For full details of Apple’s podcast specification, visit the iTunes website. 

Category 
This is the category which iTunes should categorise the podcast under. It should be just a 
single category, such as Comedy or Technology. 

Keywords 
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This allows you to be more specific than a category. Think of them as tags, allowing you to 
refine the description of the episode so perhaps Mac, OS X, RapidWeaver would be 
considered Keywords of a Technology-centric show. Keywords should be comma and 
space separated. 

Author 
Enter your name, or the company name you wish to associate with the show. It will appear 
in the iTunes source list and over-ride the email address defined in the blog’s RSS setup. 

Subtitle 
If you’re looking to add some extra details about the episode, a subtitle may be useful. 

Summary 
If you want to add more in-depth show notes specifically for iTunes, perhaps detailing the 
entire content of the show (such as topics covered, guest appearances, etc), you can enter 
them here. 

Explicit 
iTunes allows you to flag any content that may contain any explicit content (such as 
profanity). Checking the ‘Explicit’ box will ensure that iTunes is made aware of the 
content. You should always ensure your episodes are flagged if they contain any explicit 
content, as the iTunes Store may remove any incorrectly-labelled podcasts. 

Once you’re finished editing the details for this episode, click OK. When you next publish 
your site, RapidWeaver will attach the chosen files to your blog post, and generate the 
necessary code that ensures podcast clients can download the episode from the server. 

If you wish to edit the settings for an entire podcast, perhaps to mark all episodes as 
Explicit by default, open the Page Inspector’s Plugin Settings tab, and then click on 
Advanced > iTunes. There you can specify a custom show logo there, which will be 
displayed in iTunes as album art, and also as your show’s artwork on the iTunes Store if 
you submit your podcast for listing on the iTunes Store’s Podcast section. 

Note: Submitting your podcast requires you to sign in to the iTunes Store 
with your Apple ID. 

Blog Settings 

There are five sub-tabs, that contain all your settings. 

- General: Set Archiving, Permalink and Commenting options. 

- Categories: Create and manage the categories for your blog posts. 
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- Tags: Create and manage any tags you apply to your blog posts. 

- RSS Feed: Configure the RSS feed for your blog page. 

- Advanced: Advanced options related to the Date Format, Custom iTunes Tags (for 
podcasts), Custom RSS Channel, and enabling the Dynamic Sidebar. 

  

General Settings 

The top section of the General tab contains the archiving options for your blog in which 
you can customise the archive behaviour, if used. By default, archiving is active. Disabling 
it will cause RapidWeaver to keep all of your blog’s posts on the same page, growing 
longer with each blog entry you add. If enabled, archiving will move all your old posts to 
separate pages, keeping only the current week’s or month’s posts on the main page, as 
selected in the ‘Archive by’ popup menu. You can also set the minimum number of posts 
that must appear on the main blog page before older posts are archived, and whether or 
not to show gaps in the list of available archives. 

- The middle section of the General tab allows you to enable Permalinks in your blog and 
to set the Permalink’s link title. If you use summaries in your blog entries, you may 
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choose whether the Permalink points to the summary rather than the blog entry itself by 
clicking the Include Summary checkbox. When published, the Permalink will point to 
the summary, which will include a ‘Read more...’ link to the full blog entry. You may also 
change the phrase used for ‘Read more...’ links. 

- RapidWeaver allows you to add commenting to your blog using the Disqus service. Once 
you have registered with Disqus, and enabled comments for your blog, you will need to 
enter the Disqus 'Site Shortname' into RapidWeaver. 

Note: Older versions of RapidWeaver supported the Haloscan and JS-KIT 
commenting services. As these services are no longer available, any older 
projects will need to move to Disqus in order for comments to be enabled. 

  

Categories 
Categories are automatically enabled for each blog you create, allowing you to set a 
category or classification of your blog entries. If you’d rather not use categories, you can 
disable them by unchecking the Enable checkbox. When categories are enabled, you can 
also choose to display the number of blog entries that are in each category within the 
sidebar - check the Show Post Count option. 

You can create additional categories for your blog by clicking the (+) button at the bottom 
of the categories list and typing the name of the new category. To remove a category, click 
on its name and click the (-) button. You may also arrange the categories in the list by 
clicking and dragging a category into a new position. At the bottom of the Categories pane, 
you will find a Separator field. RapidWeaver uses the characters in this field to delineate 
the various blog entry details such as the date, category, and permalink elements (located 
below the blog entry’s title in your blog). The default separator is a ‘pipe’ delimiter | with a 
space character before and after it for balance (e.g. ‘ | ‘), but you can use any character you 
wish. 

  

Tags 
Tags could be considered Sub-Categories, describing more accurately a blog post’s 
content. To enter a tag for a post, click in the tab box above the entry, type the Tag you 
wish to add, and hit Enter. The tag will turn to a ‘Token’ field and be applied to the post if 
tags are enabled. 

  

Emoticons 
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The Blog plugin supports 8 different smiley emotions. For example, entering :-) in your 
blog, RapidWeaver will convert it into the appropriate graphic. 

- Smile :-) 

- Laugh :-D 

- Sad :-( 

- Wink ;-) 

- Gasp :-o 

- Embarrassed :-[ 

- Angry :-| 

- Foot-in-mouth :-! 

  

RSS 
To help you increase the audience for your blog, RapidWeaver can generate what’s known 
as an RSS feed. This is a file that contains the posts from your blog, along with a link to 
view the article. Visitors to your site can subscribe to this feed in apps like Safari (where 
it’s known as Add to Shared Links on the Share menu), and RapidWeaver includes a 
link to the RSS feed in your website’s source code so that apps can automatically detect it! 
RSS is a common feature on almost every website, and we strongly recommend that you 
take advantage of it! 
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Before you can syndicate your blog or broadcast your podcasts, you must first configure 
your blog to use RSS feeds, set your default Podcast tags and customise your blog page’s 
options. Open the Page Inspector, and choose the page-specific settings tab - you can 
quickly jump to this tab with the keyboard shortcut Cmd Option 5. 

Some sites truncate their RSS feeds, to drive visitors to read the original on the web. While 
we typically wouldn’t recommend you do this, you can specify how many words from each 
of your blog entries should be included in your RSS feed (from one to fifty words) by 
selecting the checkbox labelled Summarise text in RSS Entries at the bottom of the 
pane. 

  

Advanced 

Date Format 
You can customise the way the date and time are shown by selecting the ‘Date Format’ 
sub-tab in the Plugin Settings area. 

In this tab, you can specify how the date and time are displayed, including separators. As 
you make changes to the settings, an example is displayed in the lower portion of the 
pane. 

iTunes 
You may create default values for your iTunes tags and any custom RSS channel tags used 
in your Podcasts. The values entered here will become the default tags for all of your 
Podcasts, but you may override these values in any Podcast if desired by using the iTunes 
Tags and the Custom RSS Tags tabs in the Add Podcast pane. 

When you click the Podcast tab in the blog setup area, two sub-options are available: 
iTunes Tags and Custom RSS Channel Tags.  

To set the default iTunes tags to be added to your Podcasts, click the Enable Custom 
iTunes Tags checkbox and edit the fields on the Podcast: iTunes Tags pane. If you wish 
to add default custom RSS Channel tags to your Podcasts, click the Custom RSS 
Channel Tags sub-tab. 

Channels 
Use the Custom RSS Channel Tags sub-tab to add any tags not addressed using the iTunes 
Tags sub-pane, or to add any new Channel tags that may be added to iTunes in the future. 
As a rule, this should be unnecessary, but the ability to add custom RSS Channel tags 
remains available if needed. 

Other / Dynamic PHP Sidebar 
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Enabling the dynamic PHP sidebar improves the sidebar navigation on blogs with a large 
number of tags and categories, and substantially reduces the number of files that require 
updating when the number of tags and categories changes. 

Note: if your pages do not currently have a .php extension, enabling the 
Dynamic PHP Sidebar will require RapidWeaver to create new blog pages, 
and permalink article pages, with a .php extension. After enabling this option, 
you should consider connecting to your server through an FTP client such as 
Transmit, and remove your site. Then, use the File > Re-Publish All Files 
option to ensure the new PHP-based pages are uploaded. 

Contact Form 
The Contact Form plugin lets visitors send you messages and attachments using an easy-
to-use form. Contact forms are highly customisable with a number of options available. 
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Note: Contact Forms require PHP to be installed on your server. The good 
news is that it’s almost certainly the case that your web host supports PHP, 
however some free (or extremely low-cost) hosts may not. If you are unsure 
whether your server supports PHP, contact your hosting company before 
publishing a page created with the Contact Form plugin. 

The Contact Form plugin supports six different form elements: 

- Text Field: a single-line text field. 

- Text Area: allow visitors to type larger messages, without line or character-limits. 

- Check Boxes: allow you to one or more the displayed options by clicking its box. 

- Popup Menus: allow you to make a single selection from a defined popup menu. 

- Radio Buttons: allow you to make a single selection from a list of options. 

- Attachments: allow visitors to attach files when submitting the form. 

Each of these elements can be marked as a Required field, meaning that item must be 
selected or completed before a visitor can successfully submit the form. 

Getting Started 
When you add a Contact Form to your project, some form fields are pre-configured with a 
standard contact form that enable visitors to send a message to the address specified in 
the Page Inspector. If you allowed RapidWeaver to access your Address Book when first 
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launching the app, the primary email address specified in your “Me” card will be pre-filled 
for the contact form to use. 

To add a new field item to the form field list, click the [+] button at the bottom of the 
Form options area. Type a label for the new field’s name and then select the desired field 
type. To remove an option from the form, select the item click the [–] button at the 
bottom of the Form options area. 

Tip: When typing the field name for a newly-added element, use a separator 
at the end, such as a colon (:) or a hyphen (–). This ensures that the label and 
visitor’s content is separated in the submitted form. 

Rearranging the order of form elements is as easy as clicking and dragging a form option 
into your preferred location. 

  

Popup Menu and Radio Button Options 
If your Contact Form includes either a popup-menu or radio-button elements, you should 
create a list of corresponding selection options for each element. When you’ve chosen a 
popup-menu or radio-button element in the top table view, you can then add, edit, and 
remove options in the lower section in the Contact Form’s contact view. 
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Click the [+] button, shown below the Options list, to add a new option for the 
select popup-menu/radio-button. The new option will be added with a default Option 
Name of "Name". Double-click the Option name to edit the item. Repeat as required to 
add your desired number of options for the selected form element. 

To remove a selection option, simply select the option within the Options list and then 
click the [–] button. 

  

Contact Form Setup 
With the content of your form now sorted, it’s time to focus on the configuration options 
that’ll ensure the contact form reaches you! The Plugin Settings tab the Page Inspector 
provides you with a few options here, which you’ll want to double-check. 

- Send To: Enter the email address you want the form’s contents to be sent to. 

- From Name: The form field you want to appear as the name of the person the email 
was sent from. 

- From Email: This option defines which form field is used as the email an email should 
be marked as being sent from. You’ll want to ensure that the form field that contains a 
visitors email is the one chosen here. 

Note: If you follow the steps explained in “A Word About Spam” below, the 
email will be sent from your email address. The sender’s email will still be 
shown in the contents of the email that you receive, however. 

- Subject: The form field that will be used as the subject in any received any emails from 
the form. 

- Required: Enter the message you want the form to display if a required field is left 
blank when submitting the form. 

- Symbol: this symbol will be used to highlight required fields on your contact form. 

- Submit Button: This label will be used on the Submit button for your form (by default 
it’s simply ‘Submit’). 

- Reset Button: Sometimes it can be useful to have a Reset button that clears the form 
for a user. This option customises the text on the Reset button (by default it’s simply 
‘Reset’). 
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A Word about Spam 
To reduce the likelihood of spam being sent through contact forms, some web hosts 
require contact forms to be sent via a specific email address that is linked to your account. 
If you’re not receiving emails sent via a contact form, you may want to consult your host to 
see if this option is required for your site. 

If your host requires you to use this setup, confirm the email address you need to use on 
your form, and then open the Page Inspector’s Plugin Settings tab. Ensure that the “Sent 
To” email address is the one specified by your host, and then check the Send email 
using your email address option. 

HTML 

The HTML page type allows you to enter any HTML code in the content area of your site 
in the editing view. Your code can be as simple or complex as your knowledge of HTML 
and web development. Or you can simply use this page to paste embedded code such as 
Google Maps, or even videos hosted on YouTube or Vimeo. 
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If you want to create an HTML page that retains the theme of the other pages in your 
website, be sure to leave the ‘Apply Theme’ checkbox located in the ‘Page’ tab of the Page 
Inspector selected. Unticking this box will remove the theme layout from the page, giving 
you an entirely blank canvas to start from scratch. 

Note: You can enter anything into the HTML page type, including Javascript, 
CSS, PHP and more. Just remember that the page’s extension needs to reflect 
the content on the page, so be sure to check that the Page Inspector has been 
set up correctly. If you're using PHP, you should also check whether your web 
host supports PHP as some hosts may not support PHP. 

Sitemap 
Not to be confused with an XML Sitemap (which is enabled for the benefit of search 
engines), sitemaps can be incredibly useful in larger website, allowing users to browse an 
complete list of the pages on your website. 

RapidWeaver will add every page in your project on a Sitemap page, unless you’ve chosen 
to not show a page in your site’s navigation menu. 
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Offsite 
Sometimes it’s useful to place a link to another website in your website navigation. In this 
case, add an Offsite page to the Page List to direct visitors to external pages. 
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This can be useful if you have a page that isn’t created in RapidWeaver, such as a Twitter 
page, an affiliate service, or another external website to which you want to direct your 
visitors to from the navigation menu. 

Using the Page Inspector, you can configure the address that the menu item should link 
to. Links can open in the same window, or a new window by configuring the settings in the 
‘General’ tab of the Page Inspector. 

Note: When choosing a page to link to, always ensure you start links with 
http:// so that visitors are taken to the correct location. 

File Sharing 

The File Sharing page type allows you to easily share files, web addresses and other 
documents with visitors to your website. You can link to either files on your Mac or 
located somewhere else online. Any files you link to from your Mac will be copied and 
uploaded when publishing your project (just as they would be when adding the file as a 
resource to your RapidWeaver project). 
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At the top of the File Sharing view is a styled text area, which will be shown above the 
download links on your published page. You can add text, format it, and add images as in 
the Styled Text plugin. 

The lower area of the File Sharing page displays a table of files, or web addresses, shown 
on the final webpage The table is a series of rows, with one row for each file or URL you 
add. Each file has four fields for information: ‘Title’, ‘Description’, ‘Source’ and ‘Source 
Type’. To rearrange the contents of the table, click and drag items. 

  

Sharing Files 
Drag in your first file from the Finder. 

The title used for files added to the list is automatically created from the file's actual 
filename. To change the title of any file, double-click the Title field to change it. You can 
also choose to add a description for each file in using the adjacent Description field 

Click and drag items within the list to arrange them in any preferred order. 

Note: If you’re sharing large files, these can take some time to upload - as 
well as taking a long time for visitors to download! You may want to try 
compressing large files you want to share; in the Finder, right-click on the file 
you want to compress and choose Compress File. Then drag the file into 
RapidWeaver. 

  

Sharing URLs 
To link to a file that’s already published or available online, press the [+] button to create a 
new entry in the Files list. Enter a Title and Description for the new entry and then choose 
a Source Type of Web Address. Click within the Source field and enter the full URL of the 
file you wish to share. 

  

Linking to Project Resources 
To link to a resource in your RapidWeaver project, press the [+] button to create a new 
entry in the Files list. Enter a Title and Description for the new entry and then choose a 
Source Type of Resource. 

Select the resource to be shared, and choose OK. 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Chapter 10 

Preferences 
RapidWeaver 7 comes with a number of preferences to help you tweak the app’s 
behaviour. 

General 

Show Projects Window 
If you prefer to open projects directly from the Finder, you can turn off the RapidWeaver 
Projects window. 

Show Notifications 
RapidWeaver will show notifications when publishing your site via OS X’s Notification 
Centre by default. You can turn them off here. 

Play Sounds 
If you prefer RapidWeaver not to play sounds with notifications, you can turn them off 
here. 

Default Theme 
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The default theme is the theme that will be applied to new projects when they’re created. 
By default it’s set to the new Offroad theme. 

Hide Classic Themes 
RapidWeaver ships with over 50 themes, including themes from previous versions of 
RapidWeaver. If you don’t use these themes, you can choose to hide them from the Theme 
Browser, and Addons Manager. If you open a project that uses one of these themes, the 
theme will temporarily be shown in the Theme Browser. 

Enable Autosave and Versions 
RapidWeaver ties into the OS X Autosave and Versions feature. When OS X thinks that an 
autosave is necessary, RapidWeaver will be instructed to save your project. With large 
projects, this may take some time. This option will allow you to turn off Autosave in 
RapidWeaver, while leaving it enabled for all other apps. 

Enable Web Developer Tools 
The Web Developer Tools allow you to inspect RapidWeaver’s preview output, and use the 
same tools as found in Safari. 

Use Dark theme in code views 

Enable Code Completion 
RapidWeaver’s code views offer code completion, but we know that some people prefer to 
turn it off. 

Automatically resize larger images 
When dragging in an image, RapidWeaver will store the image at its original dimensions. 
To reduce the size of your RapidWeaver project, you can opt for RapidWeaver to resize 
images when dragging them in. 
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Publishing 
Clear page status when publishing 
Whenever RapidWeaver publishes your site, by default the “changed” flag is removed to 
let you know that all changes have been published. In RapidWeaver 7, as there is no 
“Export”, simply “Publishing to a Local Folder”, the preference to reset this status on 
“Export” has been removed. 

After Publishing Locally 
If you’re publishing your RapidWeaver project to a folder on your Mac (either to preview, 
or to upload using another means), this option will open the homepage of your exported 
site after the export completes. 

Enable smart publishing 
RapidWeaver’s smart publishing system means only changed pages or files will be 
uploaded – this makes uploading projects from RapidWeaver nice and fast! It’s enabled by 
default. If for any reason you would prefer RapidWeaver to re-publish all files each time 
you publish, unchecking this option will turn off smart publishing for all projects. 

Enable upload logging 
By default, this option is not enabled. It should only enabled if you’re experiencing 
problems publishing your website and have been asked to enable it by the Realmac 
Software support team. 

Maximum Concurrent Uploads 
By default, RapidWeaver will try and connect to your server using 3 concurrent 
connections to minimise the time required to publish changes to your website . If your 
host has a different limit to the number of connections, you can manually set 
RapidWeaver to use a different number of concurrent upload connections. It’s important 
to note however that lowering the number of concurrent uploads increases the time taken 
to publish your website. 

Updates 
We regularly issue updates to RapidWeaver, and strongly recommend that you keep your 
copies of RapidWeaver up to date. RapidWeaver will regularly check for updates, and 
prompt you when a new version is available. RapidWeaver does not automatically 
apply updates. 
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We’ve designed the update flow to be as smooth and as quick as possible. Updates are 
normally just a few megabytes in size as RapidWeaver applies a small patch to your 
existing copy instead of re-downloading a full copy of the app. 

Note: If you ever need to re-download a full copy of RapidWeaver, we list all 
versions of RapidWeaver on the RapidWeaver Release Notes webpage. 

When checking for updates, RapidWeaver will include an anonymous system profile, 
which helps guide the development of the app. No personal information is included: 
RapidWeaver only shares the type of Mac you’re using, the OS X version you’re using, and 
other anonymous diagnostic information. 

Beta Updates 
We regularly offer previews of the next RapidWeaver update. If you’re curious to see 
what’s in the pipeline for RapidWeaver, you can opt-in to receive these update. However, 
as pre-release software can contain undiscovered bugs you’ll be asked to confirm that you 
are happy with the risks associated with pre-release software before receiving any beta 
updates. 

Addons 
Most RapidWeaver users end up installing at least a few of the addons available for the 
app. Whether it’s a theme, plugin, or stack, all these addons are stored in RapidWeaver’s 
Addons folder. 
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By default, RapidWeaver follow’s Apple’s guidelines regarding where to store these files. 
However, if you find yourself needing frequent access to the contents of the folder, you 
may want to consider using the Addons preferences to change the folder’s location. 

Note: If you use RapidWeaver on multiple Macs, you may find it useful to 
store the Addons folder in a location such as Dropbox. If you do choose this 
location, we strongly advise against using RapidWeaver on two machines 
concurrently. 

The default location is “Managed by RapidWeaver”, which is a hidden folder within your 
user account: ~/Library/Containers/com.realmacsoftware.rapidweaver/Data/Library/
Application Support/RapidWeaver. If you wish to choose an alternative location, this 
must be configured using RapidWeaver - you should not attempt to use any third-party 
apps (or Terminal.app commands) that may offer this. 

When you choose an alternative location, RapidWeaver will offer you the choice of moving 
your addons to the new location. Any addons that already exist at the new location with 
the same filename will be overwritten. 

Note: You cannot change the Addons folder location when any RapidWeaver 
projects are open. Changing the Addons folder location requires a restart.  

To configure other copies of RapidWeaver to use your synced Addons folder, switch those 
copies of RapidWeaver to use your newly-chosen (and synced) folder in the respective 
copies’ preferences. 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Appendix A 

Keyboard Shortcuts 
Project Shortcuts 

Formatting Shortcuts 

Command-Shift-N New Project

Command-O Open... (project from Finder)

Command-N Add Page...

Command-D Duplicate (Selected) Page

Command-Delete Remove (Selected) Page

Command-W Close Window

Command-S Save

Command-Shift-S Save As...

Command-Option-R Revert to Saved

Command-Shift-E Export Site...

Command-Shift-Option-E Export Changes to Default Folder

Command-Shift-K Publish Site...

Command-K Publishing Settings

Command-Shift-M Mark All Pages & Resources as Changed

Command-Shift-Option-M Mark All Pages & Resources as Unchanged

Command-P Preview Page in Default Browser

Command-Option-P Preview Page in... (opens list of browsers)

Command-Option-V Paste Clipboard content as plain text

Command-Shift-Option-V Paste Clipboard content & match style (of existing 
content)

Command-V Paste
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Other Shortcuts 

Command-B Bold selected text

Command-I Italicise selected text

Command-U Underline selected text

Command-plus (+) Increase size of selected text

Command-minus (-) Reduce size of selected text

Command-Shift-C Show Colours

Command-{ Align Left

Command-| (pipe-key) Centre Align

Command-} Align Right

Command-period (.) Ignore Formatting

Command-Option-period (.) Clear Formatting

Command-Shift-L Format selected text as a list

Command-1 Project Settings

Command-2 Pages & Resources List

Command-Option-L Show Page List

Command-Option-T Show Themes

Command-4 Show Media Browser

Command-5 Show Snippets

Command-6 Show Bookmarks Manager

Command-7 Show Addons Manager

Command-Option-7 Reveal Addons Folder in Finder

Command-8 Show Health Check

Command-Shift-i Show / Hide Page Inspector

Command-Option-1 Jump to Page Inspector General settings*

Command-Option-2 Jump to Page Inspector Sidebar settings*

Command-Option-3 Jump to Page Inspector’s HTML Code & Meta Tags 
section*

Command-Option-4 Jump to Page Inspector Theme Variations section*
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* If the Page Inspector is not open when using these keyboard shortcuts, RapidWeaver will open it in addition to 
taking you to the respective tab.  

Command-Option-5 Jump to Page Inspector Page Options*

Command-R Preview Page

Command-Shift-R Reload Page in Preview

Command-Option-U View Source of Selected Page

Command-Control-F Enter/Exit Full Screen
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Appendix B 

Migrating to Master Styles 
Previous versions of RapidWeaver previously made it hard to layout your site in a single, 
clearly-defined place, and the Master Styles option is the solution to this! Some older 
projects are probably using individually-defined theme variations on each page (or a saved 
Theme Style which has been manually selected on each page). In this quick guide, we’ll 
show you how to take a Theme Style that is applied to every individual page in your 
project, and change the pages to use a Master Style. 

1. Locate a page that uses the layout and theme variations that apply to every page in your 
website. 

2. Open the Page Inspector with the Info button on to main toolbar, and choose the 
Theme Variations tab. 

3. Click on the “Cog” to reveal the theme styles menu, and choose Save Custom Style. 
Give your Theme Style a name, and save it. 
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4. Now choose the Master Styles item in the Page List. 

5. On the right-hand side, you’ll be able to select the theme variations that apply to the 
Master Style - in the popup menu, choose the Theme Style that you saved in step 3. 
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6. With the Master Style set, it’s time to change each page to use the Master Style - 
currently, this must be done on each individual page. 

7. Select each page in the Page List, and in the Page Inspector, check the Use Master 
Style option. 
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Appendix C 

Glossary 
Addon 
The term Addon is a generic term used to refer to a third-party product that can be used 
inside RapidWeaver. An addon can be a plugin, theme, or stack. A stack is a third-party 
addon that is used within the Stacks plugin. A listing of available addons can be found on 
the RapidWeaver Community website. 

Addons Manager 
The Addons Manager is a central place to view all the Addons you have installed for your 
copy of RapidWeaver. You can open it by selecting the View menu, and choosing Show 
Addons Manager. You can also use the keyboard shortcut Cmd 7. 

Auto Save & Versions 
RapidWeaver makes use of the OS X Auto Save system, which your Mac triggers at times 
when it thinks there’s changes to save. Auto Save is controlled by OS X itself, and there is 
no way to manually force a save or version to be made. 

Depending on the third-party addons used in your projects, you may wish to turn off Auto 
Save & Versions if you notice it affecting the performance of your Mac when switching to 
other apps via the OS X app switcher or Dock. 

Concurrent Uploads 
RapidWeaver can upload more than one file at a time when publishing your website - up 
to a maximum of 6 concurrent files, depending on your webhost. 

When RapidWeaver publishes your site, it analyses your site’s structure to determine the 
most efficient way to publish your site, ensuring uploads are as quick as possible.  

It’s worth noting that some hosts do not allow more than 1 concurrent connection. If your 
host limits the number of concurrent connections, RapidWeaver may report an error, and 
some hosts will forcibly disconnect any app that attempts to make multiple connections in 
a short space of time. 

CSS Consolidation 
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CSS consolidation is a feature in RapidWeaver that brings together all the stylesheets in 
your RapidWeaver site into one file, reducing the number of files and file requests made to 
your web server. This feature is enabled by default, and makes your site faster to load. 

CSS Consolidation can be turned off by going to the General settings area in the Page 
List, and clicking on Advanced Settings option. 

FTP 
Acronym for File Transfer Protocol, the most common method for uploading websites to a 
web host. 

RapidWeaver supports the three most common ways to upload files: FTP; FTPS (FTP with 
TLS); and SFTP (FTP over SSH). Depending on the requirements of your hosting provider 
you may need to tweak the settings to ensure your site publishes correctly. 

By default, RapidWeaver uses Passive Mode FTP, as this is the most common (and most 
robust) way to connect to a server. However, RapidWeaver can use Active Mode FTP if 
specified by your hosting provider. Please be aware that Active Mode requires that an FTP 
server make a connection to your Mac, and this may not be permitted by firewall software 
you may have on your Mac (or that an employer enforces on their network). Wherever 
possible we recommend that you use Passive Mode FTP, and the majority of webhosts do 
not support Active Mode FTP. 
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Hosting Provider (Host, Web Host) 
RapidWeaver provides you with the tools to build an amazing website, but getting it online 
requires some webspace that is provided by a third-party hosting provider. LittleOak is the 
official RapidWeaver hosting partner and provides great RapidWeaver-centric hosting - 
learn more here. 

Image Editor 
A popover that appears when double-clicking on an image you’ve added to a Styled Text 
page, or Styled Text area in some third-party plugins. You can re-size, rotate, and edit the 
metadata for an image to improve how your page appears to search engines. 

Media Browser 
The Media Browser allows you to browse media libraries from Aperture and iPhoto (where 
supported by OS X), Photos (available on OS X Yosemite and later), and Adobe 
Lightroom. Images from the Media Browser can be dragged into any page in your project. 
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Page Inspector 
The Page Inspector allows you to modify the settings for your page - for example, the 
Filename of the published page, the page’s name in the navigation menu, and many other 
options. Settings for the plugin that you’re using to build each page also appear in a sub-
tab of the Page Inspector. The Page Inspector appears on the right-side of the 
RapidWeaver window, and can be toggled with the keyboard shortcut Cmd Shift i. 

Page List 
The page list appears on the left of every project window, and shows pages, resources, and 
settings groups for your project. 

Page Status 
RapidWeaver places a blue dot to the right of a page’s name if there are changes that have 
been made to the page since you last exported or published the page. Depending on the 
preferences you have configured, RapidWeaver will reset the page status (to “Unchanged”) 
when exporting and publishing a site. 

Page Type (Plugin) 
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Your RapidWeaver project is made up of pages, each of which can be created using 
specific page types or plugins. RapidWeaver includes 10 page types, and there are over two 
dozen third-party plugins available via the RapidWeaver Community website. 

Projects Window 
The Projects window is shown when you launch RapidWeaver. There are two tabs - 
Examples, and Recent. The Examples tab allows you to choose one of five built-in example 
sites; the Recent tab shows you the most recent projects you’ve opened in RapidWeaver. 

Note: The Recents tab uses the same list as the Open Recent… menu item 
provided by OS X. The number of projects shown is set using the Recent Files 
preference in System Preferences’ General pane. 

RapidWeaver Community 
The RapidWeaver Community website is dedicated to providing you with everything you’ll 
need to build and expand your RapidWeaver websites. It’s the official home to all things 
RapidWeaver: video tutorials, addon listings, our free weekly podcast “The RapidWeaver 
Show”, and much more. 

RapidWeaver License 
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Your RapidWeaver license is displayed by our store after completing your transaction, and 
is also sent to you by email. If you don’t have a license yet, you can purchase one via the 
Realmac Software Store. 

Which version of RapidWeaver is my license valid for? 

Each paid upgrade to RapidWeaver has its own license style. We always issue customers 
with a full license (even when taking advantage of upgrade pricing). This is to ensure 
customers who’ve used RapidWeaver the longest aren’t made to jump through hoops to 
upgrade, and ensure that you only ever need one license to unlock RapidWeaver. There’s 
no funny business like special “Upgrade Serial Numbers” that require you to enter older 
licenses for the app. 

- RapidWeaver 7 licences are a string containing numbers and letters. 

- RapidWeaver 6 licenses are very long, and start with RMS 

- RapidWeaver 5 licenses contain three words separated by a dash 

- Licenses for both RapidWeaver 3.6 and RapidWeaver 4 start with RW3SN 

- Licenses for RapidWeaver 3.5 and earlier start with RWPL 

Note: You will need to be connected to the internet to activate your 
RapidWeaver 7 license. 

If you need to retrieve your RapidWeaver 7 license, you can visit our license retrieval page, 
and you may find that RapidWeaver does not need a license in some cases. This is because 
the app will automatically try to re-activate itself, if it has previously been activated on 
your Mac. If you need to de-activate RapidWeaver on your Mac, just  

RapidWeaver Project (RapidWeaver Document Format) 
When you save a new document in RapidWeaver, a new Project file is created. 
RapidWeaver 7 Project files have a .rw file extension, and when you open a document 
created with an older version of RapidWeaver, a new .rw file will be created. 

Older Project Formats 

RapidWeaver 6 Project files have a .rw6 file extension. 
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RapidWeaver 4 & 5 project files have a .rwsw file extension. 

RapidWeaver 3 project files have a .rwp file extension. 

Note: Older Project files that have not been saved RapidWeaver 5.4.1 will not 
open in RapidWeaver 7. You should follow the Upgrade Guide in this manual 
to ensure your project files open with RapidWeaver 7. 

Smart Publishing 
Smart Publishing is the method by which RapidWeaver uploads only the changed pages in 
a project, not the whole site. 

RapidWeaver will upload your entire site when publishing it for the first time, or after a 
change in publishing details, and after that only upload changed files. You can re-publish 
your complete site via the File menu > Re-Publish All Files option. 

SSH 
Short for Secure Shell, SSH is a way for users to connect and authenticate with another 
computer using an encrypted connection. Instead of using a username and password 
combination to identify yourself to the server, SSH uses a pair of cryptographic keys: one 
is for private use (i.e. you never share this with anyone else), and a public key (which can 
be uploaded to a server or any other computer) which when matched allows you to access 
a server. 
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As SSH keys are stored in a hidden location on your Mac (~/.ssh) you must make sure you 
back up your SSH keys - there is no way to retrieve a lost SSH key (unlike a forgotten 
password!). 

Stack 
A stack (note the lowercase “s”) is an addon for the Stacks plugin. A stack is developed by 
a third-party developer. You can install a stack by double-clicking the stack, or by right-
clicking on it, choosing Open With… and selecting RapidWeaver 7. 

 

Stacks 
The Stacks plugin is a third-party addon for RapidWeaver made by YourHead Software. 
The plugin works with individual stacks (note the lowercase “s”) to create fluid, flexible 
and responsive layouts for RapidWeaver. There are also more than 600 stacks available 
from other developers, and they’re listed on the RapidWeaver Community website. 

Theme 
The layout and design of your RapidWeaver site is controlled by a theme. A theme is a 
type of addon made up of HTML, CSS and Javascript files, and over 50 themes are 
included with RapidWeaver itself. Given the ease of changing a theme in your project (a 
single click in the Theme browser is all it takes!) we’ve also made it incredibly easy to 
discover more than 240 third-party themes on the RapidWeaver Community website. If 
you’re happy with HTML, CSS, and Javascript we also publish our Theme SDK and 
documentation on GitHub, allowing you to build your own themes. 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Appendix D 

Troubleshooting 
We’re always updating RapidWeaver, to keep things running smoothly. However, if you do 
find yourself running into a problem with RapidWeaver, there’s some very quick and easy 
ways to help diagnose what might be going on. As RapidWeaver supports third-party 
addons (such as plugins, which run within RapidWeaver) it’s important to be aware that 
Realmac Software cannot offer technical support for third-party addons and you’ll need to 
contact the developer directly for help. If you’re ever unsure how to contact the developer 
of an addon, their details can be found on the RapidWeaver Community website. 

First Steps 

1. Launch RapidWeaver without any third-party addons enabled. Close RapidWeaver, 
and re-launch the app while holding the Option key. If the issue does not re-appear 
when not using any RapidWeaver addons, you may want to try uninstalling individual 
addons one at a time to figure out which addon developer to contact. 

2. Make sure you’re running the latest version of RapidWeaver. You can re-download 
RapidWeaver from the Realmac Software website at any time, and we strongly 
recommend that you keep RapidWeaver up to date. 

3. Make sure that your plugins are up to date. The RapidWeaver > Check for 
Updates… option checks for updates to both RapidWeaver and any third-party 
plugins - RapidWeaver also checks for updates on launch. 
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4. Use the latest version of OS X. Every release of OS X sees performance and stability 
improvements, and we recommend that you use the newest version of OS X supported 
by your copy of RapidWeaver. 

5. Consider enabling beta updates. We regularly post new pre-release betas of 
RapidWeaver with new features, fixes, and enhancements, and it may well be that 
we’ve already fixed your problem! You can use the Updates preference pane to opt-in. 

6. When reporting an issue using the built-in Problem Reporter, include your contact 
details. We frequently check problem reports that are sent in, and in many cases may 
contact you about a problem report - either to request some further details, or to offer 
you some suggestions. We aim to reply to as many problem reports as we can. To help 
us locate individual issues for our attention, the problem reporter analyses and groups 
incoming reports, helping us identify the most important items. Because of the 
automated grouping that occurs, it may be that you don’t hear from us if a problem is 
already being worked on. 

7. Visit the Realmac Software Forums - there may well be some extra information (or a 
fix) available! 

If a particular addon causes a problem either with your site or the performance of 
RapidWeaver, you should always contact the developer of the addon so that they can 
investigate the issue. 

HTML Issues 
If you're experiencing an issues where code entered into RapidWeaver isn't applied to 
your website as expected, make sure any HTML, CSS, or JavaScript code used in your 
project is not formatted to use Smart Quotes. If there are small fragments of raw HTML 
code visible, this is likely the cause - and very easy to fix. 

Note: Smart Quotes are disabled by default in RapidWeaver 7, however OS X 
may have Smart Quote substitution enabled. You can turn this off in System 
Preferences’ Keyboard pane. 

  

Disable Smart Quotes 
To turn off Smart Quotes in RapidWeaver, disable the Smart Quotes option in the Format 
menu. 

Page !  of !78 84

http://forums.realmacsoftware.com


Examples of Smart Quotes 
The example HTML code below shows two HTML links; the first link does not use Smart 
Quotes and so this link would be encoded correctly. However, the second link below does 
use Smart Quotes and so may be encoded incorrectly when Previewed or Published. 

Code with Smart Quotes disabled (HTML will render as expected): 

<a class="custom-class" href="http://www.apple.com" title="Link to 
Apple">Apple</a> 

Link with Smart Quotes enabled (HTML will not render): 

<a class=“custom-class” href=“http://www.apple.com” title=“Link to 
Apple”>Apple</a> 

Remove Smart Quotes from Existing Text 
You can remove Smart Quotes from any text selection by going to the Format menu, 
holding the Option key, and choosing Remove Smart Quotes. 

Ignore Formatting 
To help ensure code entered on a page displays correctly, you can let RapidWeaver know 
that the text should be considered as raw HTML code, and that it’s not formatted text that 
should be converted to HTML when exporting your site. 

To flag any HTML code in your projects, select the text and choose Format > Ignore 
Formatting. 
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If you’re looking to analyse code errors using the Web Inspector, you can enable the Web 
Inspector in RapidWeaver’s preview by going to the Preferences 

Publishing 

The published version of my website doesn’t match RapidWeaver’s Preview 
Use the File menu’s Re-Publish All Files option to re-upload your site. It may be that 
some files are missing and were not uploaded. You may also want to remove the history 
and browsing data in your web browser. In Safari, this is found on the History menu > 
Clear History…, in Google Chrome it’s found on the Chrome menu > Clear 
Browsing Data…. 

I can’t publish my site! 
The biggest cause of publishing issues is that the credentials entered are not accurate, so 
it’s incredibly important that you double-check the details you’ve entered. 

To view your configured publishing details, choose File > Publishing Settings 
(Command-K) - or the Publishing item in the Page List - and check that all the fields 
are entered correctly: Server Address, Username, Password, and Path. 

Entering an incorrect Path is the most common cause of publishing problems in 
RapidWeaver. Some common site paths may include: 

/ 

httpdocs/ 

www/ 

public_html/ 

Note: Some hosts may require you to use a path that begins with a forward 
slash (which has a special meaning to a web server). Unless your explicitly 
states that your path should start with a forward slash, you should not 
attempt to use a path with a forward slash - otherwise you may well run into 
publishing difficulties. 

The list above is by no means an exhaustive list as paths vary greatly between different 
hosts, so if you’re still experiencing issues, please consult your web host’s online help to 
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determine the Path required to upload to the correct folder. Sometimes, the Path may be 
known as the “Upload Folder”. 

You may also want to contact your web host directly and ensure that they have not made 
any recent changes to the server which may affect your settings, and that you’ve not run 
out of webspace. 

  

Check for Updates to RapidWeaver and Addons 
Check for updates to RapidWeaver or any installed addons by opening RapidWeaver and 
choosing RapidWeaver > Check for Updates… in the menu bar. 

You can download the most up-to-date version of RapidWeaver 7 via the RapidWeaver 
release notes webpage. If you’re unsure where to look for updates to your addons, the 
RapidWeaver Community site lists the most popular third-party Addons. 

Different Server Configurations 
RapidWeaver has a number of options to configure publishing - particularly if you’re using 
FTPS uploading. Please try the each of the options available, as some hosting providers 
require specific settings. Due to the nature of how FTP works, RapidWeaver cannot 
reliably detect the correct settings that you should use. 

  

Check for Limits on Concurrent Connections 
If your host limits the number of connections which can be made to your server, you can 
set RapidWeaver to use a smaller number of connections when publishing. 

To do this, open RapidWeaver’s Preferences window, and adjust the slider for the 
Maximum Concurrent Uploads option before attempting to publish your project once 
again. 

“Couldn’t connect to your FTP server” Error 
If RapidWeaver consistently displays this message when publishing, try disabling 
Extended Passive Mode – which is enabled by default in the FTP Publishing Setup. 

To do this, show the Publishing Setup window (Command-K), select the settings button 
next to the FTP Protocol field, then choose to disable the Use Extended Passive Mode 
option. 

Still need help with Publishing? 
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If you do get in touch with us, please be sure to include the following details in your 
message: 

1. Who are you hosting your website with? 

2. Which version of RapidWeaver are you using? 

3. What version of OS X you are running on your Mac? 

4. How large is your RapidWeaver project file? 

5. Which, if any, third-party addons are you using with your project? 

6. Are you seeing an error message when publishing? Please include the full text of the 
error or, ideally, a screenshot. 

RapidWeaver can also be configured to produce a more in-depth report about publishing 
that the Realmac Software support team can use to identify potential problems. 

1. First of all open RapidWeaver’s preferences (Cmd,) and select the Publishing 
preferences pane. 

2. Make sure that the Enable Upload Logging option is checked. 

3. Quit RapidWeaver. 

4. Re-open your project in RapidWeaver. 

5. Attempt to republish your RapidWeaver project by choosing File > Re-Publish All 
Files. 

6. If the publishing feature returns an error, go to the Help menu, and choose Copy 
Support Logs. 

7. Finally, please paste the logs copied to the clipboard into your message. 

Error Messages 

Exporting 
If you’re seeing an error message when exporting your site, this may mean that there’s a 
problem with either an addon or a resource in your project. If an error message appears 
consistently when exporting a particular page, take a look at the page - are there any 
resources missing, or a particular stack that may be causing a problem? 
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Contacting Realmac Software 
When contacting Realmac Software, please include as much detail as possible. Please also 
use the Help menu’s Copy Support Logs feature, and paste the contents into your email to 
the Realmac Software support team. 

To contact Realmac Software, just send us an email! We aim to reply to all messages 
within 2 business days, however it’s normally much quicker than that. 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Appendix E 

Useful Links 
The community around RapidWeaver is vibrant and full of great resources for extending 
and improving your site. Here’s some of the most popular! 

RapidWeaver Community - Video tutorials, addons, and more! 

RapidWeaver Homepage - Download links, and helpful guides. 

Realmac Software Forums - Chat with other RapidWeaver users around the world. 

RapidWeaver Release Notes - Download almost any version of RapidWeaver. 

The RapidWeaver Show - The free, weekly official podcast about all things RapidWeaver. 

@realmacsoftware on Twitter - The latest Realmac news in less than 140 characters. 

@RapidWeaver on Twitter - The latest RapidWeaver news in less than 140 characters.
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